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Chapter 1 : Writing your first Django app, part 1 | Django documentation | Django
Assuming that your class library's name is TestClassLibrary, to use the www.nxgvision.comgs file, you need to right click
the project>Properties>Settings>Create new settings file, then you'll find a www.nxgvision.comgs under the Properties
folder.

Configuring compiler settings Compilation output locations There are individual compilation output folders
for your sources and test sources, and for each of your modules. By default, the results of compilation are
output to: At the module level, you can specify any desirable compilation output location for the module
sources and tests individually. Specifying compilation output folders The compilation output folders are
specified in the Project Structure dialog File Project Structure. In the Project compiler output field, specify the
corresponding path. Select Modules, select the module of interest, and select Paths. The controls that you want
are in the upper part, under Compiler output. Configuring compiler settings You can modify the list of
recognized resources, exclude certain paths from compilation, select the desired compiler, configure
annotation processing, etc. On the Compiler page , you may want, for example, to modify the regular
expression that describes the extensions of the files to be recognized as resources the Resource patterns field.
Use semicolons ; to separate individual patterns. See the list of wildcard characters and examples. Use to add
items to the list. If an excluded path is a dependency of the source code being compiled, this path will be
included in compilation and processed by the compiler as required. If a file contains errors and fails to
compile, but it is not important for the current project state, or if you want to skip some files and not to include
them in the output directory, you can exclude such files from compilation. On the Java Compiler page , check
if the compiler being used is the one that you want. If necessary, select a different compiler. On the
Annotation Processors page , configure the annotation processing parameters. Apply the changes and close the
dialog. It automatically configures the Java compiler to produce class files that will link against an
implementation of the given platform version. If you need to switch this option off, clear the checkbox in the
settings.
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Check that the Gain = in Project Cars 2 and check the overall FF strength the driver's settings is high enough. Regards
[LBR]Boss Apr 12 @ am.

You can view or modify properties associated with your projects in either the Properties window or the Project
Property Pages dialog box. The project type determines where the property appears in Visual Studio. Note The
options available in dialog boxes, and the names and locations of menu commands you see, might differ from
what is described in Help depending on your active settings or edition. This Help page was written with the
General Development settings in mind. To view or change your settings, choose Import and Export Settings
on the Tools menu. To view project properties In Solution Explorer, select a project. On the View menu, select
Properties Window. In the Properties window, modify the properties you want to change. If you want to
modify properties that are specific to a project configuration, you need to open the Project Designer. These
pages generally contain the properties that apply to the entire project and those that are specific to a selected
configuration. On the Project menu, choose Properties. The Project Designer opens. The Common Properties
settings in the Solution Property Pages dialog box help you to organize what are included in different builds of
a project or solution. Here are several typical ways to use these properties. Choose Property Pages on the View
menu. In the Solution Property Pages dialog box, select a set of Common Properties from the pane on the left.
Enter values for the properties displayed on the right. To determine how multiple projects run when you start
the debugger Open the Solution Property Pages dialog box. Select Startup Project set under Common
Properties. In the pane on the right, select Multiple Startup Project. In the Action field for each project, select a
start option: To set the order in which multiple projects run when you start the debugger Open the Solution
Property Pages dialog box. Select the Startup Project set under Common Properties. Select a project, and then
click Move Up to run that project earlier when you start the debugger, or click Move Down to run the project
later. To make one project dependent upon another Open the Solution Property Pages dialog box. Select the
Project Dependencies set of Common Properties. Select a project in the current solution on the Project
dropdown menu. In the Depends on field below, select the check boxes of any other projects that must be built
first, before this project is built. Select the Project Dependencies set under Common Properties. Select the
project you want to build last in the Project dropdown menu. In the Depends on window, select the check
boxes beside all projects you want to build before this one. Select the project you want to build next-to-last in
the Project drop-down menu. In the Depends on window, select all projects you want to build before this one.
Continue this process, working backwards from the last project built to the first, until there is no Depends on
option listed for the project that will be built first.
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Specify the Base Unit for Project Drawings Specifies whether units-based properties are reported in inches or
millimeters. Report Nominal Diameters of Imperial Content In.

How do calendar option settings affect working times? What is a base calendar? A base calendar is used as a
template that the project calendar, resource calendars, or task calendars are based on. It defines the standard
working and nonworking times for the project. It specifies the work hours for each work day, the work days
for each week, and any exceptions, such as holidays. You can select a base calendar to use as the project
calendar or as the basis for a resource calendar. You can also apply a base calendar to specific tasks. Project
has three default base calendars: Monday through Friday, 8: The 24 Hours calendar can be used to schedule
resources and tasks for different shifts around the clock, or to schedule equipment resources continuously. You
can also create your own base calendar, which is useful if you have alternative schedules for multiple
resources. For example, you might have resources working part-time, hour shifts, or on weekends. What is the
project calendar? The project calendar defines the working and nonworking days and times for tasks. Project
uses this calendar to schedule tasks that do not have resources assigned or that have a task type of fixed
duration. By default, the Standard base calendar is used as the project calendar, but you can reflect alternative
schedules by using other base calendars. The project calendar specifies when project work can occur. In this
project calendar, every day of the week is a working day. In this project calendar, work can occur only on
weekdays. The working days and hours in the project calendar reflect the working days and hours for your
whole project. You can specify special days off, such as company holidays. You can also indicate other
nonworking times to reflect periods when the whole team will be working on nonproject activities, such as
company meetings or department retreats. The project calendar is set by clicking the calendar in the Calendar
list in the Project Information dialog box. For more information about accessing and modifying the project
calendar, see Set working times, vacations, and holidays for your project. What is a resource calendar? They
affect a specific resource or category of resources. By default, the working time settings in the resource
calendar match the project calendar. However, you can customize the resource calendar to show individual
schedule information, such as vacations, leaves of absence, or equipment maintenance time. By clicking
Change Working Time on the General tab of the Resource Information dialog box, you can edit resource
calendars to indicate nonworking time. You can also create or assign different base calendars for individual
resources, or groups of resources, to indicate specific working hours. For example, you can assign a resource
to a calendar that you created for carpenters who may be working during a time that is different from other
workers. If you have resources that work alternative schedules, such as part-time or the night shift, we
recommend that you set up and apply a separate base calendar for each shift. When Project schedules the
project, it uses the resource calendar to schedule the tasks that do not have a fixed duration and that have
resources assigned. For example, if a resource has a week of vacation specified on his or her resource
calendar, Project will not schedule the task for that week. Initially, the resource calendar settings match the
project calendar. Top of Page What is a task calendar? Task calendars make it possible to schedule tasks
during nonworking time, as defined by the project calendar or resource calendar. For example, you can set up
a task calendar if you have a task that needs to be worked on overnight or through the weekend. You create a
task calendar in the Change Working Time dialog box as a new base calendar. You then apply the base
calendar to a task by using the Advanced tab in the Task Information dialog box. If you have applied a task
calendar to a task that already has assigned resources, by default, the task is scheduled for the working times
that the task calendar and resource calendars have in common. If you want to schedule the task by using only
the task calendar, select the Scheduling ignores resource calendars check box on the Advanced tab in the Task
Information dialog box. For more information about accessing and working with task calendars, see Create a
calendar for a task within Project or Assign a calendar to a resource or task. Calendar option settings on the
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Calendar tab in the Options dialog box Tools menu, Options command define the time settings in Project, but
they do not determine when work can be scheduled. Only calendars can determine working and nonworking
times. On the Calendar tab, you can specify default settings, such as the day each week starts on, the month in
which the fiscal year starts, the time of day for any date manually entered, the total work hours per day, and
the number of days per month. For example, the Default start time option specifies the start time that Project
assigns to tasks by default when you enter a start date without specifying a time. Additionally, the Hours per
day option defines the number of hours that Project calculates for a task when you enter a duration in days,
such as the default setting of 8 hours for 1 day. Entering a duration of 2 days is equivalent to entering a
duration of 16 hours. If you change the working times on a calendar, remember that Project uses settings on
the Calendar tab to determine how many hours define a day, week, or month. If the working time in a calendar
differs from the Hours per day or Hours per week settings on the Calendar tab, the Duration field may not
display the duration value that you expect. For example, if a calendar is set up with a four-hour work day, but
the default hours per day is set to eight hours in the Options dialog box , then a one day task will appear across
two days. You may want to consider matching the calendar settings to the working time on the Calendar tab.
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Project managers who are accustomed to automatic scheduling with past versions of Project can turn the manual
scheduling feature off for specific tasks or for the entire project. Some projects, especially complicated ones, may
require Project's powerful scheduling engine to take care of scheduling for you.

To change a task type, double click the task name in the Gantt chart, then click the Advanced tab. You set the
task up with a day duration and 80 hours of work. The task now has two units assigned, with a 5-day duration
and 80 hours of work. The task now has an 8-day duration, with 64 hours of work and 1 resource unit. The
task now has hours of work, with a duration of This means that the task can take only the amount of work that
you specify: In this example, the task has 1 full-time resource available for 8 hours each day, and it has a day
duration with 80 hours of work. The task now has 2 units assigned, with a 5-day duration and 80 hours of
work. In order to get the task done in 80 hours over 8 days, 1. This means that the task must be completed in
the duration that you specify. Again, in this example, the task has 1 full-time resource available for 8 hours
each day, and it has a day duration with 80 hours of work. If you find out that another resource can assist on
the task, Project recalculates the work assigned to each resource. When just 1 resource was assigned to the
task, that resource had 80 hours of work to complete. When you assign another resource to the task, each
resource has 40 hours of work to complete over the same day duration, for a total of 80 hours of work. The
task now has hours of work, with a duration of 10 days and 1. Dates also are never recalculated for a cost
resource assignment, because you cannot modify the work or units. Tips and Gotchas Explanation Look out
for effort-driven tasks If you click Fixed Work in the Task type list, you cannot change the Effort driven
setting for the task. Fixed work tasks do not have flexible work values and are therefore always effort-driven.
See more about effort-driven tasks later in this article. Add a column to help you change task type You can
view and change the task type for each task directly in your view by inserting the Type field. Click the column
to the right of where you want to insert the new column, click the Insert menu, and then click Column. In the
Field name list, click Type. Use indenting to outline, not task types If you want to change the hierarchical
structure of a task or subtask as part of an outline structure for your project, you need to indent or outdent the
task rather than change the task type or add a deadline date. Top of Page How does effort-driven scheduling
affect the schedule? For all tasks, after you assign a resource, the task is scheduled according to this formula
assuming tasks are the default fixed-units task type: When you assign or remove people from a task, Project
lengthens or shortens the duration of the task based on the number of resources that are assigned to it, but
Project does not change the total work for the task. This is called effort-driven scheduling. This setting is
usually turned off. To turn it on, click File, click Options, click Schedule, then select the New tasks are
effort-driven check box. Although effort-driven scheduling can work in most scenarios, you may want to
change this behavior to more accurately reflect what happens on a particular task when resources are added or
removed. For example, you may want to see the total work increase as you add more people to a particular
task. Right-click a task, click Task Information , and then click the Advanced tab. Uncheck the Effort driven
check box. You cannot remove effort-driven scheduling from fixed work tasks. Fixed work tasks do not have
flexible work values, and are therefore always effort-driven. When you work with effort-driven scheduling,
keep the following in mind: Tips and Gotchas Explanation Effort-driven does not apply to the first resource
assigned The effort-driven calculations apply only after the first resources are initially assigned to the task. Be
aware of Fixed-unit tasks If the assigned task type is Fixed Units, assigning additional resources shortens the
duration of the task. Be aware of Fixed-duration tasks If the assigned task type is Fixed Duration, assigning
additional resources decreases the individual unit values for resources. Be aware of Fixed-unit tasks If the
assigned task type is Fixed Work, assigning additional resources shortens the duration of the task. Some tasks
can be set to effort-driven Summary tasks and inserted projects cannot be set to Effort driven. Top of Page
How do manual and automatic scheduling affect the schedule? Knowing the differences between manually
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scheduled tasks and automatically scheduled tasks is key to understanding how Project schedules your project.
Generally, manually scheduled tasks put you in control of the schedule. When you add a task to your schedule,
it stays put. Take a look at the picture below. It shows the two different types of tasks, the first two manually
scheduled, and the last two automatic. Note that for the manually scheduled tasks, the duration is a text value
as well as a number. By definition, automatically-scheduled tasks with valid durations, start dates, and finish
datesâ€”and therefore, barsâ€”are automatically drawn by Project. Now, it gets a little tricky sometimes with
the information you provide for manually scheduled tasks. All that is needed for Project to draw bars on a
manually scheduled task are three time values: If you set two of these values for a manually scheduled task,
the third value will be calculated by Project automatically, and the task will remain manually-scheduled. Tasks
are manually scheduled by default. Project managers who are accustomed to automatic scheduling with past
versions of Project can turn the manual scheduling feature off for specific tasks or for the entire project. To
change all tasks to be automatically scheduled, click New Tasks: Automatically Schedule at the bottom of the
Project application window. This new feature gives you greater flexibility and control over planning and
managing the schedule. Why would you care? Well, at times project schedules are often very informal. They
begin as simple lists of dates from e-mails, meeting with stakeholders, or a hallway conversation. Project
managers very often do not have complete information on work items. For example, they may only be aware
of when a task needs to be started, but not its duration until they have an estimate from their team members.
Also, they may know how long a task will take, but they do not know it can be started until they have approval
from the resource manager. Here are some things to keep in mind with manually scheduled tasks. Manually
scheduled tasks have their own indicators and task bars to help you distinguish them from the "classic"
automatically scheduled tasks. When a task is in manually scheduled mode, the Start, Finish, and Duration
columns can be blank or include text values in addition to recognizable dates. Switching scheduling modes
You can change a task back and forth from manually scheduled to automatically scheduled. When you change
a task from manually scheduled to automatically scheduled, Project is going to have to make some decisions.
Control slippage If a manually scheduled task has to be delayed due to a slippage, its successor tasks will not
be automatically pushed out. Project managers can decide to keep the original dates if their resources are able
to proceed as planned, or delay the successor tasks if there are hard dependencies. The duration of a manually
scheduled task will not change as more resources are assigned to it, or removed from it. Learn more about later
in this article. The following table shows how Project attributes are defined and used for scheduling manually
and automatically scheduled tasks. Not used by Project to help schedule the project if value is not in a
recognizable format for duration. Only numbers representing time length and units can be used, such as "14d"
or "2 months". Work Only numbers representing time length and units can be used, such as "14d" or "2
months". Resources Can be assigned to tasks. Can be assigned to tasks. Used by Project to Help determine
best schedule. Will change the duration of tasks if tasks are set to effort-driven, unlike manually scheduled
tasks.
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Try out ProjectSpecific package from PackageControl. I just have added support for project specific package settings.
Assume you want to turn on "console_log" for www.nxgvision.come-settings for only current project, then (after installing
ProjectSpecific), add following lines to www.nxgvision.come-project file.

Requiring code analysis can improve the quality of the code that is checked into the code base. Note This
feature is available only if you are using Team Foundation Server. Code analysis check-in policies are set in
the project settings and apply to each code project. Code analysis runs are configured for code projects in the
project. Code analysis runs are performed on the local computer. When you enable a code analysis check-in
policy, files in a code project that are to be checked in must be compiled after their last edit and a code
analysis run that contains, at a minimum, the rules in the project settings must be performed on the computer
where the changes have been made. For managed code, you set the check-in policy by specifying a rule set
that contains a subset of the code analysis rules. You can add pre-processor directives to disable specific rules
for the individual code projects in your Azure DevOps project. After you specify a check-in policy for
managed code, team members can synchronize their code analysis settings for code projects to the Azure
DevOps project policy settings. To open the check-in policy editor In Team Explorer, right-click the project
name, point to Project Settings, and then click Source Control. In the Source Control dialog box, select the
Check-in Policy tab. Do one of the following: Click Add to create a new check-in policy. Double-click the
existing Code Analysis item in the Policy Type list to change the policy. To set policy options Select or clear
the following options: Option Description Enforce check-in to only contain files that are part of current
solution. Code analysis can run only on files specified in solution and project configuration files. This policy
guarantees that all code that is part of a solution is analyzed. Enforce Code Analysis for Managed Code
Requires that all managed projects run code analysis and build before they can be checked in. To specify a
managed rule set From the Run this rule set list, use one of the following methods: Select a Microsoft standard
rule set. Then, type the version control path of the rule set in the source control browser. The syntax of a
version control path is:
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If you want to modify properties that are specific to a project configuration, you need to open the Project Designer.
These pages generally contain the properties that apply to the entire project and those that are specific to a selected
configuration.

To specify project settings for your Premiere Pro project, do the following: The startup screen appears. The
Recent Projects list should be populated with the projects you last opened. General tab The General tab
contains these sections: Action and Title Safe Areas: It is recommended you leave the settings in this section
at their default values. They do not affect the video in any way. They simply determine where guides are
displayed on the Program Monitor and Source Monitor to help plan title placement and see where TV overlay
molding may hide the edges of video. Again, it is recommended that you leave the Display Format settings at
their defaults unless you need to display video increments in feet or frames rather than timecode or you need
to display audio in milliseconds rather than at the sample rate. The only setting in this section, Capture
Format, is important to set correctly based on the media you plan to capture. Video Rendering and Playback:
This option may be active or inactive depending on the graphics card installed in your system. This feature
will be discussed in detail in Lesson 8. Click to view larger image Scratch Disks tab Scratch disks is a term
used to describe the location on your computer hard drive where various files associated with video editing are
stored. Scratch disks may be placed all on the same disk or on separate disks, depending on your hardware and
workflow requirements. The default for each type of file is Same as Project. This means all files will be stored
in the same folder or subfolders of your project file. Click to view larger image In some scenarios, you may
have good reasons to specify different locations for different files scratch disks. For example, you may have a
really fast hard drive in a RAID 0 configuration. NOTE Partitioning a single drive into multiple drives is not
helpful for performance. When you start capturing your own video clips, feel free to customize the scratch
disks to your environment. Typical drive setup Although all files can exist on a single hard drive, a typical
editing system will have three hard drives: While on the Scratch Disks tab, set a location and filename for your
new project, and click OK. Sequence settings You will be prompted to choose sequence settings every time
you create a new sequence. Since Adobe Premiere Pro assumes you need at least one sequence in your project,
it prompts you for sequence settings when starting a new project. Click to view larger image The New
Sequence dialog contains three tabs, which are as follows: This tab allows you to choose a preset for the most
commonly used and supported media types. When you capture your own video clips, choose the preset that
matches your media. The General tab allows you to customize the individual settings of a preset. However, if
you need to create a custom preset, choose the one on the Sequence Presets tab that matches your media most
closely, and then make the customization on the General tab. You may save your custom preset by clicking the
Save Preset button near the bottom of the General tab. Here you can specify how many video and audio tracks
will be added when the sequence is created. You can also add audio or video tracks later. Custom preset for
new projects If you expect to use your modified project settings on multiple projects, you can save them for
reuse by creating a customized new project preset. To do so, choose your settings, and then click the Save
Preset button on the General tab. Give your customized project settings preset a name on the Sequence Presets
tab, and click OK. The name will appear in the Custom folder under Available Presets. In this case, choose
one of the standard presets on the Load Preset tab. Adjusting user preferences Preferences are different from
sequence settings in that you typically set preferences once and have them apply to all your projects. You can
change preferences and have them take immediate effect at any time. Preferences include default transition
times, timing and number of autosaves, Project panel clip label colors, and user interface brightness you
adjusted this in Lesson 1. If you need to start fresh, load the Lesson All choices take you to the Preferences
dialog, with the appropriate category selected. You can easily move from one category to another by clicking a
category name in the list on the left. If this option is selected, any media you import will automatically scale to
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the frame size of the sequence. This may be desirable for importing a lot of still images. If you intend to do a
lot of zooming or panning, you may not want stills to automatically scale. This sets the interface brightness.
You saw this in Lesson 1. The Automation Keyframe Optimization setting is relevant when you use the Audio
Mixer to change volume or panning. This sets the default audio hardware device. This specifies how each
audio hardware device channel corresponds to an Adobe Premiere Pro audio output channel. Generally, the
default settings will work fine. This sets the frequency and number of autosaves. This sets four basic capture
parameters. The choices here are Preroll and Timecode Offset usually used only during analog video capture.
This lets you change the default Project panel medialink label colors. This assigns specific label colors to
different media types. NOTE Some sequences, such as those containing high-resolution source video or still
images, require large amounts of memory for the simultaneous rendering of multiple frames. In these cases,
you can maximize the available memory by changing the Optimize Rendering For preference from
Performance to Memory. Change this preference back to Performance when rendering no longer requires
memory optimization. It is recommended that you start with the default settings. This is usually set to Adobe
Media Player. However, some third-party capture cards may add their own video players, which you can
choose to use here. This specifies the characters to be used for font and style samples in the Adobe Titler
frame. This adjusts how many frames and audio time units are trimmed if you select Large Trim Offset a
quick way to chop off chunks of video in the Trim Monitor. Any changes you make in the preferences take
effect immediately and remain in effect the next time you start Adobe Premiere Pro. You can change them
again at any time.
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On the Calendar tab, you can specify default settings, such as the day each week starts on, the month in which the
fiscal year starts, the time of day for any date manually entered, the total work hours per day, and the number of days
per month.

The target server is specified during project creation and import, and it can be changed in the project
properties. The target server setting is the default mechanism for setting the class path for J2EE projects. For
example, if you want to take advantage of the features of JDK 1. By prompting you to specify a target server,
the workbench enforces that proper entries are added for running on the server you choose. You can also add
more than one target server for your project. In this case, the workbench prevents you from adding any facets
not supported by all of the target servers. When the project is created, the class path of the project is updated
with two class path containers. One container is the JDK container and the other is the server container. The
server container points to the directory that contains the multiple public JAR files available in the selected
server. The project then compiles based on the required JAR files located in these folders, and you do not need
to worry about adding additional JAR files from the server during development. When the project is compiled,
the JAR files are included in the class path. You can still add your own JAR files to the class path. The target
runtime environment is specified in the org. You should not edit this file manually; instead, use the properties
window as described in this topic. All J2EE project creation and import wizards prompt you to specify the
target server for the resulting projects. The list of target servers that you can choose from is filtered based on
installed runtimes, the J2EE level of the application, and the J2EE module type. All projects inside a single
EAR file must be targeted to the same server. If you create a new project and add it to an existing EAR project
during creation, the project inherits the target server setting of the EAR project. Utility Java projects that are
added to an application are targeted to the same target server as the application. Web library projects that are
added to a Web project are targeted to the same target server as the Web project. To modify the target runtime
and default server for an existing project, complete the following steps: In the Project Explorer view of the
Java EE perspective, right-click the enterprise application or module project, and select Properties. Select the
Targeted Runtimes page in the Properties dialog. In the Targeted Runtimes list, select the check boxes next to
each of the runtimes that you want to develop the project for. For more information, see Defining the installed
server runtime environments. These runtimes are grayed out. To select the primary runtime, click on a runtime
and then click the Make Primary button. If you select any runtimes for the project, you must make one of
those runtimes the primary runtime for the project. If you select only one runtime from the list, that runtime is
automatically made the primary runtime. The primary runtime is shown in bold text.
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As others have mentioned, there are project calendar settings that determine which days are counted as working days.
Perhaps your working calendar has been set to consider weekends as working days. You should check the working time
for your project in the Project -> Change Working Time menu.

To change the settings of an existing project, position the cursor on the project node and choose Properties
from the popup menu. Proceed as described in section Customizing the Project Setup. The Choose Project
panel opens. In the Categories list, choose PHP. Depending on your needs, you can create a completely new
PHP project without any previously developed source files , or import an existing local PHP application or
remote PHP application into a new project. In the Project Name text field, enter the name of the project. In the
Sources Folder field, specify the subfolder of your document root where you want to store your source files.
The document root is the folder where the local web server looks for files to open in the browser. The
document root is specified in the web server configuration file. After installation, the New Project wizard
locates the document root and by default specifies the following path: A copy of the source files must be kept
in a subfolder of the document root. However, you can have your Sources Folder in a different location than
the document root and copy source files from this location to the document root. See Specifying the Run
Configuration. From the Default Encoding dropdown list, choose the default encoding for your project. If you
want to store NetBeans metadata in a different location than your source files, select "Put NetBeans metadata
into a separate directory. The Run Configuration panel opens. In the Sources Folder field, specify the folder
from where you want to import the source files. If you are going to run the project on a local web server , do
not forget to specify copying the source files to it. In the Sources Folder field, specify the subfolder of your
local document root where you want to store your source files. Note that it is useful to be able to test the
project on a local server. The Remote Connection panel opens. You can define several configurations for one
project and switch between them back and forth. For example, if an application has been developed locally
and needs to be uploaded to a remote production server, you only need to choose another run configuration.
Run configurations apply to both running and debugging. Run configurations accommodate the following
common use cases: Developing PHP web pages on a local machine with a local web server. Therefore such
scripts can be run without a browser. This use case is common when the development is shared across
multiple people. A combination of the above use cases: During development, PHP scripts are executed if
necessary. To set the default run configuration for your project, choose the relevant option from the Run As
dropdown list on the Run Configuration panel. The following options are available: To use this configuration,
you need a hosting account on a remote server and an FTP account on this server. This run configuration does
not require that a web server be installed and running. You only need a PHP engine. The process for creating
additional run configurations, or editing the default run configuration, is described in Customizing the Project
Setup: It is almost identical to the process for creating the default run configuration, except that you use the
Properties dialog of the existing project instead of the new project wizard. Local Web Site A local web site
configuration involves a copy of your PHP source folders in the Web folder of the Apache web server
installed on your machine. It is common practice for a project to have both a local and a remote web site
configuration. Note that the procedure for setting up the local web site run configuration differs slightly
depending on whether you are creating a project from existing sources or without existing sources. To set up a
local web site configuration: If not, specify the port number explicitly, in the format localhost: If you are
creating the project from existing sources, you can choose which source file to use as the index file. If you are
creating a project from existing sources, this is a required step, unless the existing sources were already in the
web folder of your Apache server. The field by default specifies the following path: Use the Browse button to
specify a different path, if necessary. The document root is the folder where the web server looks for files to
open in the browser. The wizard detects the Apache installation type, either a component or within a package,
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and provides the path to the default location of the htdocs folder for the current installation type. Therefore, if
you accepted the default settings during the installation of the Apache server or the AMP package, choose the
path from the dropdown list. In the PHP 5 Interpreter field, specify the path to the php. Use the Browse or
Search To specify how the script execution results will be shown, select the relevant checkbox in the Open
Result In area. The results of executing a script will appear in the output window in the bottom of the
NetBeans IDE window. The default browser window will open with the results of executing a script in the
form of an HTML file. The Options dialog box closes and the system returns to the Run Configuration panel.
Customizing the Project Setup During the project creation, the basic project settings are defined: To expand
the project setup with new settings, customize the project. Position the cursor on the project node and choose
Properties from the popup menu. The Project Properties panel opens with a list of settings categories. Sources
On the Sources panel: The Web Root field shows the root folder of your application site. By default, the field
shows the Sources folder. To change the web root, click Browse and select another folder. Select the Copy
files from Sources Folder to another location, if necessary, and specify the path to the storage folder. Change
the encoding, if necessary To complete the project customization, click OK. To modify the default settings,
update the fields as during the project creation. To define a new run configuration, click New next to the
Configuration dropdown list. The Create New Configuration dialog box opens. In the Configuration Name
field, enter the name of the new run configuration and click OK. You return to the Run Configuration panel.
Define the run configuration settings in the same way as you defined the default run configuration during the
project creation and click OK. The new configuration is added to the Configuration dropdown list. To remove
a configuration, select it from the Configuration dropdown list and click Delete. To complete the project
customization, click OK. PHP Include Path On the Include Path panel, specify the location of the files that you
need to use in the project but do not need to locate together with the source files. To add a folder, click Add
Folder. The Select Folder s dialog box opens. Select the relevant folders and click Open. The new folder is
added to the list. To navigate through the list, use the buttons Move Up and Move Down. To remove a folder
from the list of included folder, select the folder and click Remove. Formatting On the Formatting panel,
define the formatting style you want to apply to your source files in the editor. You may define either global or
project-specific formatting. To define global IDE formatting: Choose "Use global options". Click Edit Global
Options. From the Language dropdown list, select the language to which the settings should be applied. From
the Categories dropdown list, select the format items to which the setting will be applied. Set your desired
formatting and click OK. Click the Help button for detailed information. To define project-specific formatting:
Choose "Use project-specific options". The hidden area displays. To add JavaScript Libraries to your project:
Download the JavaScript libraries you need, or locate them if you already have them. If your project properties
are set so that project sources are copied to another location see Sources , the JavaScript libraries are also
copied to this location. If your project is deployed on a remote server, the JavaScript libraries are uploaded to
that server the next time your project sources are uploaded to the server.
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In the Project compiler output field, specify the corresponding path. Module output folders. Select Modules, select the
module of interest, and select Paths.

You can select the required build type in the CMake settings dialog. In CLion, you can create as many build
types as needed for your development lifecycle. Use the CMake Settings dialog and choose the configuration
that is optimal for the current purposes. For example, the following code sample will be executed only if the
Debug build type is selected: For another configuration type such as Release , this code will be ignored. Select
the desired CMakeLists. CLion detected an improper CMakeLists. Now do one of the following: Find the
desired CMakeLists. Select Load CMake Project from the context menu. Compiler settings In addition to
setting a toolchain, you can use CMake options to specify a compiler. The overall effective environment for
CMake generation and build consists of: The values you specify additionally will be appended to system
variables. Otherwise, when the checkbox is cleared, your custom values will overwrite the system ones. Click
Show to view the full list of system variables and their values. Toolchain environment For example, variables
defined in vcvarsall. CMake profile environment Your custom variables specified in the Environment field.
Advanced options Changing build directory The CMake settings dialog provides an input box for specifying
the build options, and also enables you to change the CMake files generation path. CLion supports in-source
builds: Creating multiple toolchains You may want to have an individual set of tools ready to be used in
different projects for example, if your projects require different environments or CMake executables. Or you
may need different toolchains to be used in one project for different CMake profiles see the detailed
description of build configurations. In CLion, you can create and manage the list of toolchains and use them in
CMake profiles. For the latter, use the Toolchains field of the CMake Settings dialog to select the desired
toolchain from the drop-down list. Setting custom build types You can extend the list of available build types
with custom ones by setting them explicitly in CMakeLists.
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